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Before Work is Started 
1.0 Before Work is Started

Coherent product information is now available in one easily accessible 
location on the Coherent website. Filter the search by product type, 
document category, or both.

1.1 Downloads

Go to the Resources section on the Coherent website:
https://www.coherent.com/resources

• Software
• Drawing Files
• Quick Start Guides

• User Manuals
• Datasheets
• Application Notes

1.2 Products Supported

BeamView.NET supports the following cameras:

• LaserCam-HR, LaserCam-HR-II-1/2-in., LaserCam-HR-II-2/3-in.

• LaserCam-HR-II-2/3-in. 14-bit
• LaserCam-HR-UV, LaserCam-HR-II-2/3-in.-UV 14-bit

• LaserCam-HR InGaAs
For information about sensor products, go to:

https://www.coherent.com/laser-power-energy-measurement
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2.0 Safety Information

This section provides an introduction to safety information, including 
signal words and symbols that to know before measurements are taken.

2.1 Signal Words and Symbols

This documentation may contain sections in which particular hazards are 
defined or special attention is drawn to particular conditions. These 
sections are indicated with signal words in accordance with ANSI Z-535.6 
and safety symbols (pictorial hazard alerts) in accordance with ANSI Z-
535.3 and ISO 7010.

2.1.1 Signal Words

The following signal words are used in this documentation:  

2.1.2 Symbols

The following signal words are always emphasized with a safety symbol 
that indicates a special hazard, regardless of the hazard level. The icons 
are intended to alert the operator as described here:  

Signal 
Word Description

WARNING Indicates a hazardous situation that, if not 
avoided, could result in death or serious injury.

CAUTION Indicates a hazardous situation that, if not 
avoided, could result in minor or moderate injury.

NOTICE Indicates information considered important, but 
not hazard-related. ‘NOTICE’ may also be used 
when there is the risk of property damage. 

Icon Tells the operator About …
Important information or instructions for operation 
and maintenance. 
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Safety Information 
2.2 Laser Safety

Laser light that is emitted can be in the infrared or ultraviolet area of the 
electromagnetic spectrum and may not be visible to the human eye. 
Safety precautions listed here are to be read and followed by anyone 
working with or near a laser. 

At all times when the Laser Cam devices are used with a laser, ensure 
that all personnel are protected from accidental or unnecessary exposure 
to laser radiation.

WARNING! 
Direct eye contact with the output beam from a laser
causes serious eye injury and possible blindness.
Always avoid exposure to eye or skin from both
DIRECT and SCATTERED radiation.

2.2.1 General Laser Safety Precautions 

Because of its optical qualities, laser light poses safety hazards not 
associated with light from conventional light sources. 

Avoid direct exposure to the laser light, and follow these control 
measures:

• Always wear appropriate laser safety eye wear for protection against
the specific wavelengths and laser energy being generated.

Danger of exposure to hazardous visible and invis-
ible laser radiation.

Susceptible to Electro-Static Discharge (ESD).

Icon Tells the operator About …
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• Never look directly into the laser light source or at scattered laser light
from any reflective surface, even when wearing laser safety eye
wear.

• Laser beams can easily cause flesh burns or ignite clothing.

• Avoid wearing watches, jewelry, or other objects that may reflect or
scatter the laser beam.

• Terminate the laser beam with a light-absorbing material, and use
energy-absorbing targets for beam blocking.

2.2.2 Safety Precautions for Cameras

Coherent LaserCam products use a Low Distortion Face Plate (LDFP) 
installed in the camera aperture. The LDFP filter glass eliminates 
unwanted background light, provides attenuation for the laser beam, and 
provides protection for the camera sensor. 

It is important to note that Coherent recommends to not remove this 
under most circumstances, as this is the only protection the camera 
sensor has against debris and mechanical damage. The LaserCam 
warranty is void if the LDFP is removed.

CAUTION!
If the Low-Distortion Face Plate (LDFP) is removed, the
Warranty is void.

Any modification to remove the LDFP leaves the sensor susceptible to 
damage. If the LDFP is removed from the camera, special precautions 
(described next) must be taken to avoid sensor damage.
6



Safety Information 
Dust
If low-intensity spots or small circles are noticed in the camera video, as 
shown in this example, then dust may be present.  

Dust can cause distortion in the form of small circles if present on the 
LDFP filter glass, or can cause low-intensity spots if present on the 
sensor array. 

Observe the defects with a flashlight illuminating the camera. If the defect 
moves when the flashlight angle is changed, then the dust is on the 
LDFP; otherwise, it is caused by dust on the array.

To correct this situation, use clean air at low-pressure (or methanol and 
lens tissue) to clean the LDFP filter glass. Use only low-pressure micro-
filtered clean air to blow dust off the sensor. 

Take all necessary precautions to insure that nothing makes any contact 
with the sensor surface.

Fringes
If the LDFP filter glass is installed in the camera, then fringes may appear 
in the video as shown here: 

The fringe pattern is due to a second reflection off the sensor and the 
LDFP superimposing back onto the original beam image.
7
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To correct this situation, rotate the LDFP housing until the fringes are no 
longer present. Slightly turning the camera with respect to the laser beam 
can also reduce this effect.

CAUTION!
Use small, careful movements when rotating any
devices to avoid laser back reflection!

Laser Power Input
Depending on the LaserCam HR camera model, saturation occurs at 
various power levels and wavelengths. See the Operator Manual for 
the specific camera to read information about saturation levels and 
damage thresholds at various wavelengths.

2.3 China RoHS Label

The China RoHS label is as follows for the LaserCam cameras:  

This Quick Start Guide provides an introduction to the BeamView.NET 
beam-analysis software and includes the following sections:

• Features of the software

• Products supported

 
Part Name 

     Hazardous Substances 
 

(Pb) 
 

(Hg) 
 

(Cd) 
 

(Cr(VI)) 
 

(PBB) 
 

(PBDE) 

Cable Assembly X O O O O O 

SJ/T 11364  
O: GB/T 26572  
X: GB/T 26572  
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Safety Information 
NOTICE
BEFORE SUPPORT IS CALLED: 
When installing the software, check whether your
organization’s IT department has security policies or
controls in place that can cause the software installa-
tion to be incomplete.
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3.0 Features

BeamView.NET software offers the following features:

• Adjustable trigger delay assures a valid laser pulse is captured
• Additional calculations for flat-top beam analysis
• Remote mode interface and new commands

• Plug-and-play for camera set-up; support for multiple cameras
• Set variable aspect ratios for each camera
• Increase in the number of samples that can be captured; save

images using industry-standard file format

• Camera information embedded into image files. Software is back-
wards compatible, to directly import images (.bin, .img, or .png),
configuration files (.atc), and test files (.ats) generated by old Beam-
View software into the BeamView.NET
10



Installation and Set-Up 
4.0 Installation and Set-Up

Complete installation of the software before any hardware is connected.

CAUTION
When a Low-Distortion Face Plate (LDFP) is installed
in the camera unit, special safety precautions must be
taken to avoid damage to the sensor. See ’Safety
Precautions for Cameras’ on page 6 for more informa-
tion.

4.1 Software System Requirement

This section describes system requirements:

• Windows 10 (32- or 64-bit)
• 2.5 GHz processor or faster
• 2 GB of RAM or higher

• 5 GB of available hard disk space
• USB 2.0 or RS-232 port

4.2 Install the Software

1. To download the software and drivers necessary to install and
operate the BeamView.NET software, go to the Coherent website.
https://www.coherent.com/resources

NOTICE
To avoid instability of the application, it is strongly
recommended that to first disable computer hiberna-
tion or suspend mode before installing the software.
11
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2. Save the installation files to the computer.

NOTICE
It is recommended to use Administrator privileges to
install and run software.

3. Double-click to start the installation, where ‘x’ is the latest version:
BeamView_5.0.3.x.exe

• If AutoRun is enabled on the laptop or computer, installation
starts automatically.

If it does not start automatically, select Run from the Start menu and 
enter the location of the installation file on the computer.

4. Follow the on-screen instructions to complete installation, described
in the steps that follow.

For any issues with software installation, see troubleshooting tips in the 
BeamView.NET Operator Manual (PN1416724). It is available on the 
Coherent website at:

https://www.coherent.com/resources

5. When this reminder popup displays, close all other applications and
then click OK.

The License Agreement for BeamView.NET displays. 
12
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Installation and Set-Up 
6. Select the radio button to Accept the agreement, then click Next to
proceed with the software installation. Otherwise, click Cancel to stop
the software installation.

7. Review the directory shown in the ‘Browse’ line. When the correct
directory is selected, click Next.
13



BeamView.NET Quick Start Guide
8. Review the Start Menu directory that is displayed. If acceptable, click
Next, or select a different location, and then click Next.  

9. This option allows users to create a desktop shortcut. Click the
checkbox, if desired, and then click Next.  
14



Installation and Set-Up 
4.2.1 Preview Set-Up

The example screen shows the selections made. To change any settings, 
click Back. Otherwise, click Install.  

A progress bar displays during the installation.  

Because the software installation includes device drivers, another screen 
displays to request confirmation:  
15
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Click Install to continue and follow the prompts.

4.2.2 Complete Set-Up

When installation is complete, the final set-up screen is displayed. See 
the example screen, below. 

• Select Yes or No to restart the computer, then click Finish. 

4.2.3 Start the BeamView.NET Software

1. Start the BeamView.NET software. To do so, double-click the
desktop shortcut icon that was placed on the desktop during instal-
lation.  
16



Installation and Set-Up 
A splash screen like the one below is briefly displays:  

For more information, go to the Coherent website and download the 
BeamView.NET Operator Manual at:

https://www.coherent.com/resources

4.3 Connect Hardware

For detailed instructions about setting up hardware, see the User Manual 
for the appropriate camera, or check the HELP files or the 
BeamView.NET Operator Manual.

NOTICE
Complete installation of the software before any hard-
ware is connected. Also read special safety precau-
tions when using a camera that has a Low-Distortion
Face Plate (LDFP) installed in the camera unit.

After the BeamView.NET software is installed, connect the following:

1. To establish a connection with a PC, connect the USB cable into the
camera and into the USB port on the PC. The LaserCam-HR
17
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BeamView.NET Quick Start Guide
cameras require only a standard USB cable (shipped with the
camera) and a computer with a USB 2.0- compliant port.  

2. If the camera is to be used with an external trigger, connect a ‘Y’
cable. Connect the camera end by rotating the cable until the orien-
tation matches, and then pushing the connector securely onto the
mating connector.

This allows connection of an external trigger source through a BNC 
receptacle (plug-style connector). The other end connects a TTL-
level pass/fail output signal generated by BeamView from user-
configured calculation settings. 
See the HELP files or the BeamView.NET Operator Manual for 
informa-tion about configuring software for an external trigger.

3. After the camera is plugged in, wait a few seconds for the computer
to recognize that hardware.

4. In the BeamView.NET software, click the Setup tab.
18



Installation and Set-Up 
5. Click the Camera icon in the toolbar. A pop-up dialog box displays
the model of camera connected:  

If multiple cameras are later connected, the dialog box displays a
drop-down menu that lists all cameras connected.

6. Click Select to choose the camera that is needed to use. A User-
Defined ID Number is displayed. Click OK.

NOTICE
When a Low-Distortion Face Plate (LDFP) is installed
in the camera unit, special precautions must be taken
to avoid damage to the sensor. See ’Safety Precau-
tions for Cameras’ on page 6 for more information.
19
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5.0 BeamView.NET Interface

The first screen that is displayed for the software is shown here.  

For details about the functions and operations of commands in each 
window, see detail in the HELP files or the BeamView.NET Operator 
Manual. To download software or the manual, go to:

https://www.coherent.com/resources

5.1 Main Screen Tabs

The set of tabs across the top of the BeamView.NET software application 
include the following windows.

• Home

• Edit
• View
• Capture

• Analysis
• Setup

• Help
20
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BeamView.NET Interface 
5.1.1 Home Tab

The Home Tab lets users select the sample, start and stop capture, as 
well as whether to include crosshair, aperture, profiles or reference 
positions for the sample. Users can also select the level of zoom and 
coloring style. 

5.1.2 Edit Tab

The Edit tab lets users select the current sample displayed, copy the view 
plot or selected results to the clipboard, and clear the image data buffer.  

5.1.3 View Tab

On the View tab, users can select the level of zoom, display calculations, 
statistical results, and/or test results. Also, users can configure crosshair 
and various profile settings.  
21



BeamView.NET Quick Start Guide
5.1.4 Capture Tab

On the Capture tab, users can choose to show or delete the Collection 
Map, enable Continuous Wave (CW) or Pulsed capture operations, select 
trigger operations, the resolution and depth, as well as configure the 
storage buffer for samples. Users can also specify the exposure time.  

5.1.5 Analysis Tab

The Analysis tab provides commands to select analysis calculations, 
configure pass/fail options, configure overlay apertures, define reference 
coordinate positions, define inclusions areas, select system display units, 
and select averages.  
22



BeamView.NET Interface 
5.1.6 Setup Tab

The Setup tab lets users adjust properties for the selected camera, define 
input power/energy for calibrations, set the input optical magnification 
scale, input far-field optical focal length, and set password protection for 
configuration settings.  

5.1.7 Help Tab

The Help tab displays contents of the Help file, lists shortcuts, displays 
status for both system and background warning status, and license and 
copyright information for the software.  
23
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After a camera is connected, notice that the Home tab now expands the 
content on the right side of the screen, shown next.  

For more information …
For details about the functions and operations of commands in each 
window, see detail in the HELP files or the BeamView.NET Operator 
Manual. It is available at: 

https://www.coherent.com/resources
24
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Service and Support 
6.0 Service and Support

This section provides information about:

• How to contact Product Support
• How to obtain service
• Product shipment instructions

6.1 Contact Product Support

Coherent provides telephone and web-based technical assistance as a 
service to its customers and assumes no liability thereby for any injury or 
damage that may occur contemporaneous with such services.

For general Technical Support, contact a local Coherent Service 
Representative as described on the following page, or contact Coherent 
as follows:

• By phone: 1-(408)-764-4557 or 1-(800)-367-7890

• By e-mail: Customer.Support@Coherent.com

• To view a list of contact names, telephone numbers, and addresses
worldwide, visit our website: www.Coherent.com

NOTICE
Under no circumstances do these support services
affect the terms of any warranty agreement between
Coherent and the buyer. Operation of any Coherent
laser with any of its interlocks (or safety features)
defeated is always at the operator's own risk. 

For information about sensor products, go to:

https://www.coherent.com/laser-power-energy-measurement 

Please be prepared to provide the following information:

• Model or part number of the unit

• Serial number of the unit
25
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• A description of the problem
• Any corrective steps that may have attempted

6.1.1 Support in the USA and North America

If shipping products from within the United States or North America, 
contact LMC Technical Support directly, as follows:

• By phone: North America (800) 343-4912 or (408) 767-4042
• By e-mail: customer.service@coherent.com

Telephone coverage is available Monday through Friday (except during 
U.S. holidays). Inquiries received outside normal office hours are tracked 
by our automatic answering system and promptly returned the next 
business day.

6.1.2 International LMC Support

For users located in Europe or Asia, contact LMC Technical Support 
directly, as follows:

• Germany: +49–6071–968–0

• Japan: +813–5635–8680

6.2 Obtain Service

To obtain service under this warranty, Customer must notify the 
Company of the defect before the expiration of the warranty period and 
make suitable arrangements for the performance of service.

The Company shall, in its sole discretion, determine whether to perform 
warranty service at the Customer's facility, at the Company's facility, or at 
an authorized repair station.

If Customer is directed by the Company to ship the product to the 
Company or a repair station, 

Customer shall:
26
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Service and Support 
• Package the product (to protect from damage during shipping) as
instructed in ’Product Shipping Instructions’ next.

• Ship it to the address specified by the Company, with shipping
prepaid. back to Coherent in conjunction with recalibration and
recertification.

• Coherent shall pay the cost of shipping the Product back to the
Customer in conjunction with product failures within the first twelve
(12) months of time of sale or during an extended 12-month warranty
period.

6.3 Product Shipment Instructions

Users must include a Returned Material Authorization number (RMA) 
assigned by the Company on the outside of all shipping packages and 
containers. Items returned without an RMA number are subject to return 
to the sender.

To prepare a product for shipping to Coherent:

1. Contact Coherent Customer Service (see ’Contact Product Support’
in the next section) for a Return Material Authorization number.

2. Attach a tag to the product that includes the name and address of
the owner, the person to contact, the serial number, and the RMA
number received from Coherent Customer Service. Pack this tag
inside the box.

3. Use the original shipping and packaging materials, and pack the
product. If the original packing materials are unavailable, Wrap it
with polyethylene sheeting or equivalent material.

4. Make a seal on the shipping carton with shipping tape or an indus-
trial stapler.
27
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5. Add the RMA number received from Coherent Customer Service to
the shipping label on the outside of the box.

6. Ship the product to the following address:
USA
Coherent Laser Measurement and Control Service Center
Attn: (the given RMA number)
27650 SW 95th Avenue
Wilsonville, OR 97070
Europe 
Coherent Shared Services B.V.
Dieselstr. 5 b 
D-64807 Dieburg
Germany 
Asia
Coherent, Inc. Japan 
Atsugi Technical Center 
Toda 1042-4
Atsugi, Kanagawa Prefecture 
243-0023, Japan
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